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Влияние горячего изостатического прессования на структуру
 и механические свойства жаропрочных никелевых сплавов
Приведены характеристика жаропрочных сплавов на основе никеля и теория процесса горячего изостатического 
прессования (ГИП), возможности его применения, влияния на структуру и механические свойства сплавов, а также 
пример удаления дефектов в литых образцах
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Влияние состава шихты на форму графита
в сортопрокатных валках*
Исследовано влияние состава шихты с различным соотношением компонентов на твердость и  форму графита 
в отливках сортопрокатных валков из высокопрочного чугуна с невыраженным отбелом. Использование в 
составе шихты лома валков с пластинчатым и шаровидным графитом при высоком перегреве расплава в печи 
не снижает степени компактности шаровидного графита в валках.
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П
остановка проблемы. Современный этап раз-
вития машиностроения, в том числе и литейного 
производства, характеризуется все более широ-
ким применением вторичных ресурсов. Вслед-

ствие отсутствия централизованных поставок шихто-
вых материалов, вызванного сокращением выпуска 
литейных чугунов и повышением их стоимости, сни-
жено качество исходного сырья для производства 

отливок и заготовок [1]. Многие предприятия, в том 
числе вальцелитейные заводы, вынуждены исполь-
зовать шихтовые материалы со значительными от-
клонениями по содержанию химических элементов и 
особенно вредных деглобуляризирующих примесей. 
Поэтому требования заказчиков валковой продук-
ции к свойствам и структуре металла валков часто 
не могут быть удовлетворены в полной мере. Даже 
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небольшие отклонения в химсоставе сплавов часто 
влекут за собой существенное ухудшение эксплуа-
тационных свойств отливок, появление различных 
видов брака, в частности по несоответствию формы 
графита ТУ в валках из отбеленного чугуна с шаро-
видной формой графита (ЧШГ). Разработка научных 
и технологических основ производства литых загото-
вок с заданными свойствами, а также качественного 
расплава с использованием в шихте вторичных ре-
сурсов и некондиционного лома отливок собствен-
ного производства является актуальной задачей.

Анализ последних достижений и публикаций. В 
работе [2] исследовано образование центров гра-
фитизации в расплаве промышленного ЧШГ различ-
ного химического состава, выплавленного из разной 
шихты. Исследования показали, что центрами крис-
таллизации графита в расплаве чугуна служат не
неметаллические включения типа оксисульфидов 
или силикатов, а попадающие в него из шихты и
модификаторов и не растворившиеся в расплаве 
включения или микровключения графита, образо-
вавшиеся под воздействием факторов, графитизи-
рующих чугун. По результатам проведенных иссле-
дований [3] установлено, что сферолиты графита
в чугуне могут формироваться до тех пор, пока дей-
ствует эффект модифицирования магнийсодержа-
щими лигатурами. Именно в этот период рекомен-
дуется проводить инокулирующее модифицирование.

Одной из определяющих характеристик структу-
ры высокопрочного чугуна считают [4] высокие зна-
чения коэффициента формы графита Кф, принятого 
в практике как мера степени приближения графит-
ных включений к идеальной сфероидальной форме.
Эта характеристика в полуавтоматическом режи-
ме определяется различными компьютерными про-
граммами или специализированными анализатора-
ми микроструктуры. В частности, на количественном 
анализаторе «Квантимет-720» Кф рассчитывается
по соотношению между площадью отдельного
включения графита и периметром условного кру-
га с равновеликой включениям площадью. О чув-
ствительности метода свидетельствуют результаты 
исследования влияния толщины стенки отливки на 
форму графита. Показано, что с увеличением тол-
щины стенки отливки из высокопрочного чугуна Кф 
снижается от 0,82 до 0,55.

В работе [5] дан обзор предыстории методов
по количественной оценке формы графита в моди-
фицированных чугунах, включая их различные ва-
рианты [6]. Автор работы [5] предлагает метод
идентификации графитных включений в чугунах на 
основе фрактального анализа изображений, кото-
рый в последние годы все боль-
ше привлекает внимание мате-
риаловедов и литейщиков [7-9]. 
Результаты метода могут быть
использованы для определения 
взаимосвязи структуры и свойств
графитизированных  чугунов.

Анализ известных публикаций
и производственной практики по-
казывает, что для получения ка-

чественных расплавов при производстве отливок
из ЧШГ в условиях дефицита шихтовых материа-
лов необходимо решение ряда технологических и 
научных проблем. К их числу относятся:

– подбор рациональных составов шихтовых ма-
териалов с удовлетворительной наследственностью 
для обеспечения необходимой структуры отливок
из ЧШГ;

– оптимизация термовременных режимов плав-
ки для нивелирования негативных наследственных 
свойств шихтовых материалов и эффективного мо-
дифицирования чугуна;

– разработка доступных и объективных методов 
автоматизированной оценки структуры металла и 
формы графита как одной из определяющих харак-
теристик эффективности всего технологического 
процесса производства отливок из ЧШГ.

Цель работы. Исследование влияния состава 
шихты с различным соотношением компонентов на 
твердость и форму графита в отливках сортопро-
катных валков из ЧШГ с невыраженным отбелом
исполнения СШХН.

Методика проведения исследования. В ходе экс-
перимента были отлиты три опытно-промышленных 
валка с максимально приближенными массогаба-
ритными параметрами и химическим составом чугу-
на (табл. 1), но с использованием разной шихты:

– валок № 1 – исполнения СШХН-47 (47-55 HSD), 
с размерами бочки Ø 580х800 мм при использова-
нии в шихте лома бракованных валков по несоот-
ветствию формы графита ТУ в количестве 85 % от 
массы шихты с повышенным содержанием приме-
сей свинца и сурьмы;

– валок № 2 – исполнения СШХН-47 (47-55 HSD), 
с размерами бочки Ø 580х800 мм при использова-
нии в шихте лома валков СПХН в количестве 72 %
от массы шихты с высоким содержанием серы
(0,065 %) и доведением ее содержания до 0,009 %
десульфурацией магнием в количестве 16 кг при 
1360 °С;

– валок № 3 – исполнения СШХН-50 (50-62 HSD), 
с размерами бочки Ø 530х800 мм при использова-
нии в шихте лома валков СШХН в количестве 65 %
от массы чистой шихты.

В качестве остальных компонентов металлоза-
валки использовали остаток чугуна от предыдущей 
плавки и чушковый чугун. Отходы производства 
(стружку, литники и скрап) не применяли. Темпе-
ратура нагрева расплава в печах – 1450-1460 °С с 
выдержкой перед выпуском 15-20 мин. Модифици-
рование расплава и заливку форм производили при 
температуре металла 1380 и 1330 °С соответственно.

Таблица 1
Химический состав и твердость опытных прокатных валков

Номер
валка

Массовая доля элементов, % Твердость, HSD
C Si Mn P S Cr Ni Mg н/б н/т в/т

1 3,04 1,51 0,66 0,20 0,006 0,42 1,06 0,060 53 46 41
2 3,18 1,57 0,61 0,19 0,006 0,42 1,14 0,078 52 45 44
3 3,10 1,60 0,62 0,12 0,007 0,42 1,02 0,057 53 49 36

Примечание: н/б – нижняя часть бочки валка; н/т и в/т – нижний и верхний трефы валка по 
положению в форме при заливке
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Рис. 1. Структура графитных включений в чугуне валков № 1 (а, г. ж), 2 (б, д, з) и 3 (в, е, и).
Микроструктуры а, б, в – соответствуют верхним трефам; г, д, е – нижней части бочки;
ж, з, и – нижним трефам валков

Валки отливали в кокили с футеровкой. Магний 
вводили в расплав с использованием «колоколов» 
из расчета 2,7 кг/т. При каждой операции модифи-
цирования и десульфурации в ковши вводили пла-
виковый шпат и соду по 1 % от массы расплава для 
дополнительного удаления серы из расплава и на-
ведения жидкоподвижного шлака.

Для оценки влияния состава шихты проведено 
исследование микроструктуры и формы графита 
в чугуне рабочего слоя нижней части бочки, а так-
же нижнего и верхнего трефов валков. Для количе-
ственной оценки различных индивидуальных и
обобщенных характеристик графитных включений
в этих зонах использовали компьютерную програм-
му ImageJ (Freeware). Эта программа – бесплатный 
инструмент для обработки цифровых изображе-
ний [10, 11]. Она может работать либо онлайн-ап-
плета, либо в виде загружаемого приложения на лю-
бом компьютере с Java 1.4 или более поздней вер-
сией виртуальной машины. 

Программа может отображать, редактировать,
анализировать, обрабатывать, сохранять, распе-
чатывать 8-, 16- и 32-битные изображения, читать
многие форматы изображений, включая TIFF, GIF, 
JPEG, BMP, PNG, PGM, DICOM, FITS, RAW и др.
Она является многопоточной и одновременно мо-
жет выполнять такие операции, как чтение файла 
изображения параллельно с другими операциями 
обработки. 

Для загрузки в программу изображений иссле-
дуемых объектов использовали микрофотографии
нетравленых шлифов, предварительно переведен-
ных из серых полутонов в одноцветные черно-бе-
лые изображения. Эти изображе-
ния последовательно загружали в 
программу ImageJ, преобразовы-
вали в 8-битовый формат, бина-
ризировали и в результате полу-
чали контурную копию исходного 
изображения. 

Фактор формы F1 отдельных 
графитных включений и их груп-
пировок в полях оцифрованных
микрофотографий, выполненных 
при постоянном увеличении, оце-
нивался в полуавтоматическом
режиме по формуле 

F1 = 4πS/Р2, 
где S – площадь графитного вклю-
чения; Р – периметр включения.

Для решения вопроса о случай-
ном или неслучайном различии 
средних значений F1ср разных зон 
валков при неизвестных генераль-
ных дисперсиях, то есть провер-
ки нуль-гипотезы Н0: F1ср.i = F1ср.j,
использовали t-отношение Стью-
дента [12]. Такая проверка раз-
личия средних значений фактора 
формы графитных включений для 
опытных валков, отлитых с разным 

составом шихты, позволяет оценить статистическую 
значимость влияния шихты на форму графита.

Результаты исследования и их обсуждение. 
Исследования чугуна опытно-промышленных вал-
ков показали, что валки № 1, 2, 3 по структуре и 
твердости рабочего слоя, нижнего (н/т) и верхнего 
(в/т) трефов соответствуют требованиям ТУ У 27.1-
26524137-1291:2007. Установлено, что спад твердо-
сти в рабочем слое находится в пределах 2-3 HSD 
на всех валках, что характерно для валков СШХН, 
отлитых ранее. 

Строение графитных включений в чугуне бочек, 
нижнего и верхнего трефов валков представлено
на рис. 1. 

Скриншоты последовательных стадий обработки 
электронных изображений структуры в программе 
ImageJ представлены на рис. 2. В качестве примера 
количественной оценки различных параметров гра-
фитных включений выбран файл с оцифрованной 
микрофотографией графита в чугуне бочки валка
№ 3 (рис. 1, е).

Основные стадии обработки микроструктуры
и соответствующие им команды в программе
ImageJ выполняли в следующей последователь-
ности:

– открывали файл микроструктуры для преобра-
зований и анализа File => Open... (рис. 2, а);

– конвертировали изображение в 8-битовый
формат Image => Type => 8-bit (рис. 2, б);

– бинаризировали изображение Process => Bina-
ry => Make Binary (рис. 2, в, г); 

– переходили в меню анализа частиц графита 
Analyze => Analyze Particles => (рис. 2, д); 
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– в открывшейся вкладке (рис. 2, е) 
задавали параметры для анализа: огра-
ничение на минимальную площадь ана-
лизируемых частиц (Size), интервал учи-
тываемых значений фактора формы
(Circularity) и трансформирование изоб-
ражения в контурное (Outlines);

– после подтверждения заданных па-
раметров микроструктуры графита на 
дисплей выводились контурные изобра-
жения исследуемых включений с нумера-
цией для последующей идентификации 
их с индивидуальными количественны-
ми оценками в результирующем файле 
(рис. 3, б); 

– задавали параметры файла с ре-
зультатами анализа (Results) перед их 
сохранением (качество изображения в 
формате JPEG, расширение файла таб-
лицы xls и др.) File => Options;

– для сохранения файла результа-
тов Results указывали соответствующую
папку и выполняли команды: Files => 
Save as Text. В результате числовые
значения заданного перечня характе-
ристик микроструктуры графита автома-
тически заносились в таблицу (рис. 4); 

– для сохранения обобщающего фай-
ла (рис. 5) результатов анализа (Summary) опреде-
ляли соответствующую папку и выполняли команды 
File => Save As. 

Средние значения фактора формы F1ср и диспер-
сии σ2 для n включений в чугуне различных частей 
опытных валков приведены в табл. 2. Расчетные tp 
и табличные t0,95 значения t-отношения для довери-
тельной вероятности 0,95 представлены в табл. 3. 

Отсутствие статистически значимого различия 
средних значений фактора формы графита в попар-
но выбранных для сравнения комбинациях опытных 
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Рис. 2. Интерфейс программы (а) и скриншоты (б-е) последовательных стадий 
обработки микроструктуры чугуна
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Рис. 3. Исходная микроструктура графита в чугуне бочки валка № 3 (а) и его контурные изображения (б) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 4.  Скриншот фрагмента электронной таблицы с результатами анализа 

 

 
Рис. 5. Скриншот обобщающей электронной таблицы с результатами компьютерного анализа графитных включений в 
чугуне нижней части бочки валка № 3   
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Таблица 2
Оценки формы графита опытных валков

Номер
валка

Низ бочки Нижний треф Верхний треф
n F1ср σ2 n F1ср σ2 n F1ср σ2

1 13 0,75 0,013 6 0,73 0,004 3 0,61 0,025
2 15 0,69 0,015 8 0,66 0,012 9 0,66 0,013
3 15 0,76 0,005 7 0,69 0,020 4 0,38 0,040

Таблица 3
Расчетные и табличные значения t-отношения для пар валков

Номера
валков

Низ бочки Нижний треф Верхний треф
ni-nj tp t0,95 H0 ni-nj tp t0,95 H0 ni-nj tp t0,95 H0

1-3 13-15 0,28 2,06 + 6-7 0,64 2,20 + 3-4 1,64 2,57 +
1-2 13-15 1,47 2,06 + 6-8 0,84 2,18 + 3-9 0,60 2,23 +
2-3 15-15 2,09 2,04 – 8-7 0,46 2,16 + 9-4 3,41 2,20 –
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Куркострига І. О., Соценко О. В.

Вплив складу шихти на форму графіту в сортопрокатних валках
Досліджено вплив складу шихти з різним співвідношенням компонентів на твердість 

і форму графіту у виливках сортопрокатних валків з високоміцного чавуну з невираженим вибілом. Використання 
у складі шихти лому валків з пластинчастим і кулястим графітом при високому перегріві розплаву в печі не знижує 
ступеня компактності кулястого графіту у валках.
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Effect of charge makeup on the shape of graphite in section rolling
The effect of the mixture fusion with different ratios of components on the hardness 

and shape of graphite in the casting rolls from ductile iron with unexpressed chill is tested. Using a mixture of scrap 
rolls with lamellar and spheroidal graphite at high overheating of the melt in the furnace does not reduce the degree of 
compactness in the spheroidal graphite in rolls.
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Эффективность дугового глубинного восстановления
полезных примесей вторичных материалов
в металлические расплавы
Дана оценка эффективности насыщения металла полезными примесями из отходов металлургического 
производства и вторичных материалов с использованием их дугового глубинного восстановления (ДГВ) в 
металлические расплавы.

Ключевые слова: переработка отходов, дуговое глубинное восстановление, шлак, шлам, марганец, 
кремний, раскисление, легирование

О
дним из основных показателей, определяющих 
конкурентоспособность отечественной метал-
лопродукции на внутреннем и мировом рынках, 
является ее себестоимость и качество.

Снижение затрат на производство чугуна и ста-
ли может быть достигнуто в результате уменьшения 
расхода энергоносителей и сырьевых материалов, 
используемых в качестве шихты, а также полной или 

частичной замены традиционного сырья (особенно 
руд и концентратов) отходами производства или вто-
ричными материалами.

Наиболее энергозатратным звеном в технологи-
ческой цепочке получения черных металлов являет-
ся производство раскислителей, легирующих и ра-
финирующих материалов, основную долю которых 
составляют различные ферросплавы.




